LENESAS

-
7
12
o~
<
Q
-
-
D

RX/71M Group

Renesas Starter Kit+ Code Generator Tutorial Manual
For e? studio

RENESAS MCU
RX Family / RX700 Series

All information contained in these materials, including products and product specifications, represents
information on the product at the time of publication and is subject to change by Renesas Electronics
Corporation without notice. Please review the latest information published by Renesas Electronics
Corporation through various means, including the Renesas Electronics Corporation website
(http://www.renesas.com).

Renesas Electronics
Www.renesas.com Rev. 1.00 Jan 2015



Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the
operation of semiconductor products and application examples. You are fully responsible for the incorporation of these
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for
any losses incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever
for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other
intellectual property rights of Renesas Electronics or others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade,
as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial
robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster
systems; anticrime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for
which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified
ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please
evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation,
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your
noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not
use Renesas Electronics products or technology described in this document for any purpose relating to military
applications or use by the military, including but not limited to the development of weapons of mass destruction. When
exporting the Renesas Electronics products or technology described in this document, you should comply with the
applicable export control laws and regulations and follow the procedures required by such laws and regulations.

10. Itis the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as
a result of unauthorized use of Renesas Electronics products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of
Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its
majority owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4)




Disclaimer

By using this Renesas Starter Kit+ (RSK+), the user accepts the following terms:

The RSK+ is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK+ is
assumed by the User. The RSK+ is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK+. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK+,
even if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK+ product:

This Renesas Starter Kit+ is only intended for use in a laboratory environment under ambient temperature and
humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use
outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection
requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 20m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Code Generator) for RX together with the e’ studio IDE to create a working project for the RSK+ platform. It is
intended for users designing sample code on the RSK+ platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into e studio, but does not
intend to be a complete guide to software development on the RSK+ platform. Further details regarding
operating the RX71M microcontroller may be found in the Hardware Manual and within the provided sample
code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX71M Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User's Manual Describes the technical details of the RSK+ RSK+RX71M User’s R20UT3217EG
hardware. Manual
Tutorial Provides a guide to setting up RSK+ environment, RSK+RX71M R20UT3222EG
running sample code and debugging programs. Tutorial Manual
Quick Start Guide Provides simple instructions to setup the RSK+ and RSK+RX71M Quick R20UT3223EG
run the first sample. Start Guide
Code Generator Provides a guide to code generation in the e’ studio RSK+RX71M Code R20UT3224EG
Tutorial IDE. Generator  Tutorial
Manual
Schematics Full detail circuit schematics of the RSK+. RSK+RX71M R20UT3216EG
Schematics
Hardware Manual Provides technical details of the RX71M RX71M Group RO1UH0493 EJ
microcontroller. Hardware Manual




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps Bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
DVvD Digital Versatile Disc
El Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
Pmod™ Thi§ is a Digilent Pmod™ C;Qmpatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface_Specification
PLL Phase-locked Loop
RAM Random Access Memory
ROM Read Only Memory
RSK+ Renesas Starter Kit+
RTC Realtime Clock
SAU Serial Array Unit
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TAU Timer Array Unit
TFT Thin Film Transistor
TPU Timer Pulse Unit
UART Universal Asynchronous Receiver/Transmitter
USB Universal Serial Bus
WDT Watchdog timer

All trademarks and registered trademarks are the property of their respective owners.


http://www.digilentinc.com/index.cfm
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ENESANS

RSK+RX71M R20UT3224EG0100
Rev. 1.00
RENESAS STARTER KIT+ Jan 23, 2015

1. Overview

1.1  Purpose

This RSK+ is an evaluation tool for Renesas microcontrollers. This manual describes how to the e? studio IDE
code generator plug in to create a working project for the RSK+ platform.

1.2 Features

This RSK+ provides an evaluation of the following features:
« Project Creation with e’ studio.

« Code Generation using the code generator plug in.
« User circuitry such as switches, LEDs and a potentiometer.

The RSK+ board contains all the circuitry required for microcontroller operation.

R20UT3224EG0100 Rev. 1.00 ——
Jan 23, 2015 RENESAS



RSK+RX71M 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the code generator plug in for the RX family
together with the e’ studio IDE to create a working project for the RSK+ platform. The tutorials help explain the
following:

e Project generation using the e’ studio

e Detailed use of the code generator plug in for e studio
e Integration with custom code

e Building the project e’ studio

The project generator will create a tutorial project with two selectable build configurations:
e ‘HardwareDebug’ is a project built with the debugger support included. Optimisation is set to zero.
e ‘Release’is a project with optimised compile options, producing code suitable for release in a product.

Some of the illustrative screenshots in this document will show text in the form RXxxx. These are general
screenshots and are applicable across the whole RX family. In this case, simply substitute RXxxx for RX71M

These tutorials are designed to show you how to use the RSK+ and are not intended as a comprehensive introduction to
the e? studio debugger, compiler toolchains or the E1 emulator. Please refer to the relevant user manuals for more in-

depth information.

R20UT3224EG0100 Rev. 1.00 ———
Jan 23, 2015 RENESAS




RSK+RX71M

3. Project Creation with e’ studio

3. Project Creation with e studio

3.1 Introduction

In this section the user will be guided through the steps required to create a new C project for the RX71M
MCU, ready to generate peripheral driver code using Code Generator. This project generation step is
necessary to create the MCU-specific source, project and debug files.

3.2 Creating the Project

Start e” studio and select a suitable location for the project workspace

e Start e® studio and select a suitable
location for the project workspace.

¢ In the Welcome page, click ‘Go to the
workbench’.

Workspace Launcher @

Select a workspace

e studio stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: | [SENYEIEERT - Browse...

[ Use this as the default and do not ask again

97 /e < ol studio | ]
bile Edd Source Refactor Hevgate Segrch  Bregect Bum  Window Help

%) Welcome 17

e2studio

M
;

(4] @ <> @
e

Gololmon

RENESAS
Semart Manual Discovery Startug: (33%) -
. Crea}te a new C_ project by right- [P Project Explorer 52 = <}:{>| &
clicking in the Project Explorer pave
and selecting ‘New -> C Project’ as
shown. Alternatively, use the menu New v | E% Project
item ‘File -> New -> C Project’. -
g1y Import.. i CProject
ey Export. [ C++ Project
# | Refresh F5 |9 Other. Ctrl+M
R20UT3224EG0100 Rev. 1.00 RENESAS Page 9 of 53

Jan 23, 2015



RSK+RX71M

3. Project Creation with e’ studio

e Enter the project name ‘CG_Tutorial'.
In ‘Project type: choose ‘Sample
Project. In ‘Toolchains’ choose
‘Renesas RXC Toolchain’. Click ‘Next'.

e In the ‘Target Specific Settings’ dialog,
select the options as shown in the
screenshot opposite.

e The R5F571MLCxFC MCU is found
under RX700 -> RX71M -> RX71M -
176 pin.

e Click ‘Next'.

Create Directory for Project

Project type:

C Project | = '@
C Project —
Create C project of selected type
Project name: | CG_Tuterial
Use default location
C\workspace\CG_Tutorial Browse

Toolchains:

4 = Executable (Renesas)
& Sample Project

4 (= Static Library (Renesas)
@& Sample Project

> (= Debug-Only Project

> [= Executable (IAR)

> (= Others

> [= Makefile project

KPIT GNUARM-NOME-EABI Toolchain
KPIT GMURLTE-ELF Toclchain

KPIT GMURX-ELF Toolchain

KPIT GNUSH-ELF Toolchain

Renesas RXC Toolchain

Renesas SHC Toolchain

Show project types and toolchains only if they are supported on the platform

Select Configurations:
[#] Hardware Debug

@ Bacl Net> | [ Fnsh || Concel |
C Project E=R(ESR(E>S)
e2 studio - Project Generation p—
Select Target Specific Settings
Toolchain Version : ’\.-'2.03.00 v] A
Debug Hardware: ’EL VI ‘%‘%‘
Data endian : ’Little—endian data Y] “\‘1‘
Select Target: RSFST1IMLCxkFC

: Debug using hardware

[7] Debug using Simulator : Debug using simulator

Release (no debug) : Project without any debug information

Build cenfigurations will be created in the project only for the selected debug mode
options, however by default the project will be built for the active configuration i.e,
first configuration selected from group. Based on the device selection you made
(R¥700) the debug hardware (E1) and debug target (RSF57T1MLCxFC), debug
configuration will be automatically created for you.

@ <Back | Met> |[ Ensh ][ cancel
R20UT3224EG0100 Rev. 1.00 RENESAS Page 10 of 53

Jan 23, 2015



RSK+RX71M

3. Project Creation with e’ studio

e In the ‘Code Generator

dialog, ensure the ‘Use Peripheral

code Generator’ is checked.
e Click ‘Next'.

e In ‘Select Additional CPU Options’
leave everything at default values.

e Click ‘Next'.

C Project

e2 studio - Project Generation

Code Generator Settings

Use Peripheral code Generator

initialization of peripheral functions.

Automatic
generation
of peripheral
function
settings

L Y
L4

The &2 studio peripheral code generator automatically generates programs (device drivers)
for MCU peripheral functions (clocks, timers, serial interfaces, A/D converters, DMA
controllers, etc.) based on settings entered via a graphical user interface (GUI). Functions
are provided as application programming interfaces (APIs) and are not limited to

Application under
development

[- Middleware

e - Microcontroller

@j < Back “

Ned> [ Fnish || Conced |

C Project

e2 studio - Project Generation
Select Additional CPU Options

Select Additional CPU Options:

Round: ’Nearest V]
Precision of Double: ’Single precision V]
Sign of Char: ’Unsigned v]
Sign of bit Field: |Unsigned -|
Allocate from Lower Bit ’Lower bit V]

Width of Divergence of Function: ’24 Bit

Specify Global Options:

[] Replace from int with short

"] Enum size is made the smallest

[] Use try, throw and catch of C++

] Denormalized number allowed as a result

[ Pack structures, unions and classes

[] Use dynamic cast and typeid of C++

[] Saves and restores ACC using the interrupt function

Ned¢> | [  Enish || Cancel

R20UT3224EG0100 Rev. 1.00
Jan 23, 2015

Page 11 of 53



RSK+RX71M

3. Project Creation with e’ studio

e In the ‘Global Options Settings’ leave
everything at default values.

e Click ‘Next'.

e In the ‘Standard Header Files’ dialog,
select C99 for ‘Library Configuration’.
Untick ‘new(EC++)" and

others at defaults.
e Click ‘Next'.

CProject fo o] =]
e2 studio - Project Generation —
Global Options Settings |
Patch code generation ’None v]
Fast interrupt vector register: ’None VI
ROM: ’None VI
RAM: ’None VI
Address (H'): 00000000
Address Register: |INone V]
l:?j < Back ” et > ] [ Finish ] ’ Cancel ]

C Project '?'@
e2 studio - Project Generation —
Standard Header Files
Library configuration: | C{C99) -
Select Header Files:
runtime : Runtime routines (Checked and disabled by default)
[T ctypeh : Character classification routines
[] math.kh : Mathematical/trigonometric operations{double-precision)
[] mathf.h : Mathematical/trigonometric operations(single-precision)
[ stdarg.h : Variable argument functions
[¥] stdio.h : Input/Qutput
stdlib.h : General purpose library features
string.h : 5tring handling operations
[ ios(EC++) : Input/Cutput Streams
i : Memory allocation and deallocation routines
[] complex(EC++) : Complex number operations
[ string(EC++) : 5tring manipulation operations
] complex.h(C99) :Performs complex number calculation
[ ferw.h(C99) : Sets floating point environment
[[Jinttypes.h(C93) : Converts integer type format
[ wehar.h(C99) : Performs wide character
chtype.h(cgg] : Performs wide character conversion
@ <Back || Net> |[ Enish |[ Concel

R20UT3224EG0100 Rev. 1.00
Jan 23, 2015

Page 12 of 53



RSK+RX71M

3. Project Creation

with e? studio

e In the next dialog, untick all check
boxes except ‘I/O Register Definition
Files' as shown opposite. Click
‘Finish’.

e A summary dialog will appear, click
‘OK’ to complete the project
generation.

C Project

e2 studio - Project Generation

Set various Stack Areas and to add additional Supporting Files

Stack/Heap Configuration
[ Use User Stack

User's Stack Size: (H') 100

Interrupt Stack Size: (H') 300

[7] Use Heap Memory
Heap Size: (H') 400

Generation of Supporting Files

[¥] /0 Register Definition Files

o

Generate Hardware Setup Function | Nene

® v ) (|

Cancel

Summary @
Project Summary:
-------- PROJECT GENERATOR -------- -
PROJECT NAME : CG_Tutorial
PROJECT DIRECTORY : Chworkspace\CG_Tutorial
CPU SERIES: RX700
CPUTYPE: RXT1IM
TOOLCHAIN MAME : Renesas RXC Toolchain

TOOLCHAIN VERSIOM : v2.02.00

m

GEMERATIOM FILES :

C\workspace\CG_Tutorial\srchCG_Tutorial.c

Main Program
Chworkspace\CG_Tutorial\srchdbsct.c

Setting of B and R sections
Cworkspace\CG_Tuterial\src\typedefine.h

Aliases of Integer Type
Ciworkspace\CG_Tutorial\srchiodefine. h -

4 [}

Click OK to generate the project or Cancel to abort.

| OK | [ Cancel

R20UT3224EG0100 Rev. 1.00
Jan 23, 2015

RENESAS
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RSK+RX71M 4. Code Generation Using the e’ studio plug in

4.Code Generation Using the e? studio plug in

4.1 Introduction

Code Generator is an e’ studio plug in GUI tool for generating template ‘C’ source code for the RX71M. When
using Code Generator, the user is able to configure various MCU features and operating parameters using
intuitive GUI controls, thereby bypassing the need in most cases to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘r_cg_xxx.h’, ‘r_cg_xxx.c’,
and ‘r_cg_xxx_user.c’, where ‘xxx’ is a three letter acronym for the relevant MCU feature, for example ‘adc’.
Within these code modules, the user is then free to add custom code to meet their specific requirement.
Custom code should be added, whenever possible, in between the following comment delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Code Generator will locate these comment delimiters, and preserve any custom code inside the delimiters on
subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-visit
Code Generator to change any MCU operating parameters.

By following the steps detailed in this Tutorial, the user will generate a e’ studio project called CG_Tutorial.
The fully completed Tutorial project is contained on the DVD and may be imported into e’ studio by following
the steps in the Quick Start Guide. This Tutorial is intended as a learning exercise for users who wish to use
the Code Generator to generate their own custom projects for e studio.

The CG_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion and display the
results via the Virtual COM port to a terminal program and also on the LCD display on the RSK+.

Following a tour of the key user interface features of Code Generator in 84.2, the reader is guided through
each of the peripheral function configuration dialogs in 84.3. In 85, the reader is familiarised with the structure
of the template code, as well as how to add their own code to the user code areas provided by the code
generator.

The Code Generator installer is contained on the DVD. This installer must be run before proceeding to the
next section.

4.2 Code Generator Tour

In this section a brief tour of Code Generator is presented. For further details of the Code Generator
paradigm and reference, refer to the Application Leading Tool Common Operations manual
(r20ut2663ej0100_Code Generator.pdf). Application Leading Tool is the stand-alone version of Code
Generator and this manual is applicable to the Code Generator.

From the e” studio menus, select ‘Window -> Open Perspective -> Other. In the ‘Open Perspective’ dialog
shown in Figure 4-1, select ‘Code Generator’ and click ‘OK’.

R20UT3224EG0100 Rev. 1.00 RENESAS Page 14 of 53
Jan 23, 2015



RSK+RX71M

4. Code Generation Using the e’ studio plug in

Open Perspective

{

(3]

BgC/C++ (default)

Code Generatorj
Bz Cvs Repository Exploring
ﬁ*Dehug

ek Git

'\T;:'F'Ianning

r\DF{esnurce

B SVN Repository Exploring
EDTeam Synchronizing

OK

Cancel

||

In the Project Explorer pane, expand the ‘Code Generator’ and ‘Peripheral Functions’ node.
Generator initial view is displayed as illustrated in Figure 4-2.

Figure 4-1 Open Perspective Dialog

The Code

le? Code Generator - €2 studic

File Edit Mavigate Search Project Run Window Help
LN [ E IS AR S = sl I A e i =
[ Project Explorer 52 25| & ¥ = 8 | EZreripheral Functions 5

custom bat o Clock setting | On-chip debug setting | Block diagram |

5 makefile.init
4 ©H Code Generator
> A PinView
4 2 Peripheral Functions
& Clock Generator
Voltage Detection Circuit
Clock Frequency Accuracy Measur
Low Power Consumption

>

Interrupt Controller Unit

Buses

DMA Controller

Data Transfer Controller

Event Link Controller

/0 Ports

Multi-Function Timer Pulse Unit 3
Port Output Enable 3

General PWM Timer
16-Bit Timer Pulse Unit
Programmable Pulse Generator

Compare Match Timer
Compare Match Timer W
Realtime Clock

Watchdog Timer
Independent Watchdog Timer

Serial Communications Interface
Serial Communications Interface v
12C Bus Interface

Serial Peripheral Interface

CRC Calculator

12-Bit A/D Converter

12-Bit D/A Converter

Data Operation Circuit

Ll
n
n
n
n
n
n
n
n
n
n
n
n
n
w! 8-Bit Timer
n
Ll
Ll
n
n
n
n
n
n
n
n
n
n
Code Preview

>

a

< i ’

0 items selected

=R ==
5| G oeee

%] Generate Code ] T = 3

Quick Access

Main clock escillator and RTCMCLK setting
Operation

Main clock oscillation source Resonator
B Frequency 2

Oscillator wait time: 11000

Oscillation stop detsction function Disabled

PLL circuiit setfing
7] Operation

PLL clock source

Input frequency division ratio x1

Frequency multiplication factor %100

Frequency 240 (MHz)
= Sub-clock oscillator and RTC (RTCSCLK) setting

[F] Operation

Sub-clock oscillator drive capacity Drive capacity for low CL

Frequency

Oscillator wait time.

= Consele 52

Code Generator Console

[T Main clock oscillator forced oscillation (only for RTC, seftware standby and deep software standby mode)

n

(MHz)
(ss) (Actual value: 11030.909 ps)

(kHz)

(ms) (Actual value: 2296 182 ms)

CG_Tutorial/Code Generator/Peripheral Functions/Clock Generator |

Figure 4-2 Initial View

R20UT3224EG0100 Rev. 1.00
Jan 23, 2015

RENESAS
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RSK+RX71M 4. Code Generation Using the e’ studio plug in

Code Generator provides GUI features for configuration of MCU sub systems. Once the user has configured
all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button, resulting in a
fully configured e’ studio project that builds and runs without error.

Navigation to the MCU peripheral configuration screens may be performed by double-clicking the required
function in the Code Generator -> Peripheral Function on the left.

It is also possible to see a preview of the code that will be generated for the current peripheral function
settings by double-clicking the required function in the Code Generator -> Code Preview on the left.
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4.3 Code Generation

In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a UART.

431 Clock Generator

Figure 4-3 shows a screenshot of Code Generator with the Clock Generator function open. Click on the
‘Clock setting’ sub tab. Configure the system clocks as shown in the figure. In this tutorial we are using the
on board 24 MHz crystal resonator for our main clock oscillation source and the PLL circuit is in operation.
The PLL output is used as the main system clock and the divisors should be set as shown in Figure 4-3.
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ﬁ_‘J Peripheral Functions 52 5 Code Preview [ Properties -cﬂ Generate Cade (0| ¥ =0
EHE]UCK zetting | Block diagram i
M ain clock ozcillator and RTCMCLE zetting

Operation

[] Main clack ascilatar farced oscillation  [only for RTC. software standby and deep software standby mode]

Main clock oscillation souce Resonator -

Frequency 24 [MHz)

Ozcillator wait tirne 11000 [ns]  [Actual walue: 11090909 ps)

Oscillation stop detection function Dizabled -

PLL circuit setting

Operation

PLL clock source Main clock oscilator -
Input frequency division ratio %1 -

Frequency multiplication factar «10.0 -

Frequency 240 [MHz]

Sub-clock oscillator and RTC [RTCSCLE) setting

[ Dperation

Sub-clock oscillator dive capacity Dirive capacity for lav CL

Frequency 32768 [kHz]
Oecillator wait time 2ER2 T3 [mz]  [Actual value: 2296182 me)

High zpeed clock oscillatar [HOCO] satting
[] Operatian
Frequency 16 [MHz]

Low speed clock ozcillator (LOCO) setting
Operation
Frequency 240 [kHz]

m

WD T-dedicated low-speed clock oscillator [[WDTLOCO] setting

[] Operation

Frequency 120 [kHz]
RTC clock setting

[ Dperation

Clock source Sub-clock oscillatar

Swstem clock setting

Clack source PLL wircuit -

System clock (ICLK) %1 - 240 [MHz]

Peripheral module clock [FCLEA] w142 - 120 [MHz]

Peripheral module clack [PCLEE] #1744 - &0 [MHz)

Peripheral module clock for ADC [PCLEC) %144 - B0 [MHz]

Peripheral madule clock for ADC [PCLED] #1744 - =] [MHz]

Estemal bus clock [ECLE] %144 - 1] [MHz]

Flazh IF clock [FCLK) w144 - &0 [MHz]

USE clock [UCLK) %145 - 43 [tHz]
BCLE pin output setting

[ Dperation

Clack output source BCLE

SDCLK pin output setting
[] Operatian

Figure 4-3 Clock setting tab

Proceed to the next section on the Interrupt Controller Unit.
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4.3.2 Interrupt Controller Unit

Referring to the RSK+ schematic, SW1 is connected to IRQ5 (P15) and SW2 is connected to IRQ2 (P12).
SW3 is connected to directly to the ADTRGON and will be configured later in 84.3.4. Navigate to the ‘Interrupt
Controller Unit’ node in Code Generator and in the ‘General’ tab, configure these two interrupts as falling edge
triggered as shown in Figure 4-4 below.

i_xl Peripheral Functions 52 | [3f Code Preview [ Properties

{ General | Group Interpts | Interrupt B 44 selection |

7| Generate Code (2]

Faszt intermupt setting

Software intermupt zetting

[] Software intermupt
[ Software intermipt 2

MM zetting
[] MMI pin interrupt

IRG0 zetting
] 1RGO

IRG1 zetting

[ 1RG1

IRG2 setting
IRG2

IRG3 zetting
[]1RQ3

IRG4 setting
[]IRQ4

IRG5 setting
IRG5

e

[ ] Fast intermupt |nterupt zounce

Pricrity

Pricirity

Walid edge

Fin

Walid edge

Fin

Walid edge

Fin

Valid edge

Fin

Walid edge

Fin

Walid edge

Fin

Valid edge

BSC [BUSERR vect=1E)

Lewvel 15 [highest]

Lewvel 15 [highest]

Falling

F30

Low level

F31

Laow level

P12

Falling

F33

Lo level

FE1

Law lewvel

P15

Falling

Digital filker

Digital filter

Pricity

Digital filter

Pricrity

Digital filter

Pricity

Digital filter

Priciity

Drigital filter

Pricarity

Digital filker

Pricity

ta filker

Mo filker

Lewel 15 [highest)

Mo filker

Lewvel 15 [highest]

Mo filker

Lewel 15 [highest]

Mo filker

Lewel 15 [highest]

M filker

Lewel 15 [highest]

Mo filker

Lewel 15 (highest)

Figure 4-4 Interrupt Functions tab

0 [MHz)
0 [MHz)
0 [MHz)
~ [0 [MHz)
0 [MHz)
0 [MHz)
~ [0 [MHz)

|

-

m

Navigate to the ‘Group Interrupts’ sub tab and ensure that the ‘Group BLO’ interrupt is selected as shown in
Figure 4-5. The Group BLO interrupt is used for SCI Transmit End Interrupts (TEI) and Reception Error
Interrupts (ERI) as described in §4.3.5.
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f,_é *Peripheral Functions 52 3 Code Preview [ Properties

General | Group Intemupts | |pterrupt B A2 selection
Group BED zetting

[] Group BED Friority | Level 15 [highest]

Group BLO zetting
Group BLO Priority — Lewel 15 [higheszt] -

Group BLT zetting
[] Group BL1 Friority | Lewel 15 [highest]

Group ALD zetting
[] Group ALD Priority | Lewvel 15 higheszt]

Group AL1T zetting
[] Group AL Friority | Lewel 15 [highest]

Figure 4-5 Group Interrupt Functions tab

4.3.3 Compare Match Timer

Navigate to the ‘Compare Match Timer’ node in Code Generator. CMTO will be used as an interval timer for
generation of accurate delays. CMT1 and CMT2 will be used as timers in de-bouncing of switch interrupts.

In the ‘CMTO’ sub-tab configure CMTO as shown in Figure 4-6. This timer is configured to generate a High

priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

£l Peripheral Functions 52 5 Code Preview [ Properties fof Generate Code (3] 7 = [

 CMT0| oMT1 | oMT2 | CMT3 | .

Compare match timer operation zetting

m

0 Uruzed @ Uzed

Court clock zetting
@ PCLESS ) PCLE/32 1 PCLEA1Z28 1 PCLEATZ

Interval walue setting
Interval value 1 s w  [Bctual value: 1

|nterrupt zetting
Enable compare match interrupt [ChI0)

Priciity Lewel 10 -

4 1L 3

Figure 4-6 CMTO tab

Navigate to the ‘CMTL1’ sub-tab and configure CMT1 as shown in Figure 4-7. This timer is configured to
generate a High priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in
this tutorial.
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Eil Peripheral Functions 7 [ Code Preview £ Properties fo] Generate Code (3] T = B

| CMTO || CMT1:| cMT2 | CMT3 | i

Compare match timer operation setting

m

Unused @ Uszed

Count clock, setting

PCLE./2 @ PCLE/32 PCLEAM 28 PCLEAA12

Interval value setting

Interval value 20 i w  [Actual value: 20]

[nterupt setting

/| Enable compare match interrupt [Ch11)

Pricrity Lewvel 10 -

Figure 4-7 CMT1 tab

Navigate to the ‘CMT2’ sub-tab and configure CMT2 as shown in Figure 4-8. This timer is configured to

generate a High priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in
this tutorial.

il Peripheral Functions 52 [ Code Preview [ Properties o] Generate code (3] ¥ =

| CMTO | CMT1 || CMT21 CwT3 | it

Compare match timer operation setting

m

Uruzed @ zed

Count clock setting

PCLE./2 PCLEA32 PCLKA128 @ PCLE/S12

Interval value setting

Interval value 200 ms w  [&ctual value: 200.004267)

Interrupt zetting

/| Enable compare match interript [Ch12]
Pricirity Lewel 10 -

a4 L 3

Figure 4-8 CMT2 tab
4.3.4 12-bit A/D Converter

Navigate to the '12-bit A/D Converter’ tab in Code Generator. Refer to the screenshot shown in Figure 4-9
and configure the S12AD0 as shown. We will be using the S12ADO0 in 12-bit one shot mode on the ANOOO

input, which is connected to the RV1 potentiometer output on the RSK. The conversion start trigger will be via
the pin connected to SW3.
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24 *Peripheral Functions 22 | [ Code Preview [ Properties ] Generate Code 0] T = O

5124D0 | 592401 il

Setting 1 | Selting 2 |

— 512400 operation setting

() Unused @ Used

— Operation mode setting

@ Single scan mode onltinuous scan mode

Group scan mode

~ Double trigger made setting

Dizable () Enable

~ Self diagnosis setting
Mode Unused -

Voltage uzed Use VREFHO=0

— Dizconnection detection assist zetting

Charge setting Unuzed
Period 1ADCLE

— Group scan priority setting

Group & priarity Group & withaut priority
Group B action Mot restarted or continued due to Group & priarity

~4/D converted value count setting

Addition mode () Average mode

—&nalog input channel setting

Conwert [Group &) Convert [Group B) Add/Average AD value Dedicated sample and hald
ANDOD = =}
ANODT
ANOD2
ANDO3
ANDO4
ANDOS
ANDOE
ANDOT

m

OoooOoOoOE

— Conversion start trigger setting
Corversion start tigger [Group 4]

Convergion start trigger [Group B]
Compare match with or input capture to MTUDTGRA

ADTRGOH pin selection FO7 -

~Data registers setting

AD converted value addition count 1-time conversion

Data placement Right-alignment -

Automatic clearing Disable automatic clearing -
Data accuracy 12-bit sccuracy -

—Dedicated sample and hold circuit setting

Input zampling time: 8 [ps]  [The input walue is invalid.]

~AN000 / Self-diagnosiz conversion lime setting

Input zampling time: 3.BEY (ws)  [Actual value: 3.667)

—&N00T conversion time setting

Input zampling time: 3.EEY [n]  [Actual value: 3.6E7]

—&N002 conversion time setting

Input zampling time 3EET (sl [Actual value: 3.EET)

—&M003 converzsion time setting

Input zampling time: 3EBE7 [ps]  [Actual value: 3.667]

—&M004 conversion time zetting |

Input zampling time: 3.BEY (ms]  [Actual value: 3.667]

—ANO05 conversion time setting

Input sampling time 3.EEY (nz]  [Actual value: 3.667)

—&NO0E conversian time setting

Input sampling time 3.EEY [ps]  [Actual value: 3.6E7]

—&MO07 conversion time setting

Input zampling time 3EET (sl [Actual value: 3.EET)
— Conversion time zetting

Total conversion time [Group 4] 4.083 [ps)

Total conversion time [Group B] (T3]

[Mate: Continuous zampling is dizabled)

~Interrupt setting
Enable A0 conwersion end interupt [S1240D10]

Priority Level 15 [highest] -
Enable 2D conversion end interrupt for group B [S12GBADID]
Friority Lewel 15 [highest]

< [0 | 3

Figure 4-9 A/D Converter tab
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4.3.5 Serial Communications Interface

Navigate to the ‘Serial Communications Interface’ tab in Code Generator, select the SCI6 sub-tab and apply
the settings shown in Figure 4-10. In the RSK+RX71M SCI6 is used as an SPI master for the Okaya Pmod™
LCD on the PMOD1 connector as shown in the schematic.

|
Pt

sCio | sCit | sci2 | so3 | soi4 | so5 [ 506 so7 | soiz |

*Peripheral Functions 52 3 Code Preview [ Properties

General setting m‘
Function setting

1 Urzed

(71 Azynchronous mode Tranzmizzion

(71 Asynchronous mode [Mulbi-processor) Transmizzion

1 Clack synchronous mode Transmizzion

(71 Smart card interface mode Tranzmizzion

(7 Sirmple 11 busg

@ Simple 5P bus k azter tranzmit anly -
Fin zetting

FeDE/SKISOESSSCLE FO1

T=DE/SMOSIESSDAR Foo -

Figure 4-10 SCI6 General Setting tab

Select the SCI6 ‘Setting’ sub-tab and configure the SPI Master as illustrated in Figure 4-11. Make sure the
‘Transfer direction setting’ is set to ‘MSB-first’ and the ‘Bit rate’ is set to 1500000. All other settings remain at
their defaults.
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fﬂ! Peripheral Functions &3 Code Presvieu

Properties

| sc0 | son | sciz | soz | so4 | sos | S0 soi7 | sciz |

?ﬂGenerateCode 2 T =79

.

| General setting| Setting

Tranzfer direction zetting
() LSBfirst

Data inversion zetting
@ Marmal

Tranzfer rate zetting

Tranzfer clock.

Bit rate

SCKE pin function selection

Clock setting
Clock delay

[] Enable clock polarity inversion
D ata handling zetting

Tranzmit data handling
Interupt zetting

THIE pricrity

TEIE, ERIE priarity [Group BLO]

Callback function zetting
Transmission end

[ Enable modulation duty correction

@ MSE-first
) Irwerted

Internal clack -« P02
1500000 -

2585

Clock, output -

Clock is not delayed -

Data handled in interupt zervice routine

Lewvel 15 [highest] -

Lewvel 15 [highest]

(L

Figure 4-11 SCI6 SPI Master Setting

[bps]  [Actual walue: 1500000,

m

Errar: 0]

Staying in the ‘Serial Communications Interface’ tab in Code Generator, select the SCI7 sub-tab and apply the
settings shown in Figure 4-12. In the RSK+RX71M SCI7 is connected via a Renesas RL78/G1C to provide a
USB virtual COM port as shown in the schematic.
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28l Peripheral Functions 22 | [ Code Preview [ Properties

sCI0 | sCi1 | sC12 | 5013 | 5014 | 5005 | 5006 | 5007 | sCi1z |

General setting m‘
Function setting
7 Uruzed
@ Azynchronous mode Tranzmizsionreception -
(71 Asynchronous mode [Muli-processor) Tranzmizzion
(71 Clock synchronous mode Tranzmizzian
() Smart card interface mode Tranzmizzion
(7 Simple IC bug
(7 Simple 5P bus Slave tranzmit/receive
Fin zetting
RxD7 ASMISOT/SSCLT F32 -
TxD7/SMOSI7/550A7 F30 -
4 m

Figure 4-12 SCI7 General Setting tab

Select the SCI7 ‘Setting’ sub-tab and configure SCI7 as illustrated in Figure 4-13. Make sure the ‘Start bit
edge detection’ is set as ‘Falling edge on RXD7 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings
remain at their defaults.
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E8l Peripheral Functions 52 | [ Code Preview [ Properties %] senerate Code (2] Y = O
| 500 | son | soiz | soa | sci4 | sos | soe | 007 sonz | £
| General setting | SGetting |

Start bit edge detection zetting
() Low level on BxD7 pin @ Falling edae on RxD7 pin
[ata length setting
() 9 bits @ 8 hits () 7 bits
Parity zetting
@ MNone ) Even ) Odd
Stap bit length zetting
@ 1 hit () 2 bits E
Tranzfer direction setting
@ LSB-first () MSB-first
Tranzfer rate zetting
Tranzfer clock Internal clock. - P
Bit rate 19200 - [bps]  [Actual walue: 19230769, Eror: 0.16%]
[] Enable modulatian duty corection 255
SCK7 pin function SCEY iz not uzed -

MHaise filter zetting
[] Enable noise filter

Moize filter clock

Hardware flow contral zetting
@ MNone
CTS7/RTS7 pin
Drata handling zetting
Tranzmit data handling
Receive data handling
Interrupt zetting
T=I7 pricrity
REIT priority
Enable errar interupt [ERIT)
TEI7. ERI7 pricrity (Group BLO)

Callback function setting
Transmission end

Clock signal divided by 1

@ CT5
P33

Data handled ininterupt service routine

Data handled ininterupt service routine

Level 15 [highest] -

Level 15 [highest) -

Level 15 [highest)

50000000 [Hz]

) RTS

Reception end Reception errar

L

Figure 4-13 SCI7 Asynchronous Setting
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4.3.6 I/O Ports

Referring to the RSK+ schematic, LEDO is connected to P03, LED1 is connected to P05, LED2 is connected
to P26 and LED3 is connected to P27. Navigate to the ‘I/O Ports’ tab in Code Generator and configure these
four 1/O lines as shown in Figure 4-14 and Figure 4-15 below. Ensure that the ‘Output 1’ tick box is checked.
This ensures that the code is generated to set LEDs initially off.

28l Peripheral Functions 52 | [ Code Preview ] Properties Fol cenerate code (2] T = B

¢ Port] | Partl I Port2 | Part3 I Paortd | Fart5 | PaortG I Port? | Partd | Paort3 | Porte, | PaortB I PartC I PortD I PortE | PaortF | PartG | Port) | u"

FO0
@ Unused (n v (O 0Out 8 CMOS output

PO
@ Unused 0 In () Out CHOS output

POz =
@ Unused L S T R I n CHOS autput

F0O3
7 Unuszed ) In @ Out CMOS output - Dutput 1

P05 -
7 Unuszed 0 In @ Out CMOS output - Output 1

FO7
@ Unused (m v O 0Out 8 CMOS output

Figure 4-14 1/O ports — Port0

R20UT3224EG0100 Rev. 1.00 RENESAS Page 27 of 53
Jan 23, 2015



RSK+RX71M 4. Code Generation Using the e” studio plug in

2l Peripheral Functions 52 | [ Code Preview ] Properties fo| Generate code 2] T = O
| Fortd | Fart1 | Part2 | Fort3 I Fortd4 I Fort5 I FartE I Fart? I Fortd I Fort3 I Parta, I PartB I FaortC | FaortD | PartE | PartF | PartG I Pk | i |
- P20
@ Unuzed ) In ) Out Full-up ChOS5 output Clutput 1 High-drive output
- P21
@ Unused i n 0 Out Fullup CHMIOS output Output 1 High-drive output
- P22 =
@ Unused ) In 7 Out Pull-up COS output Output 1 High-drive output
- P23
@ Unuzed ) In ) Out Full-up ChOS output Clutput 1 High-drive output
-F24 L.
@ Unused i n 0 Out Fullup CHMIOS output Output 1 High-drive output
- P25
@ Unused ) In 7 Out Full-up CHOS autput Output 1 High-drive output
- P2E
) Unused & In @ Out Pull-up ChOS output - Output 1 High-drive output
- P27
) Urused & In @ Out Pull-up CMOS output - Dutput 1 High-drive output
4 11 r

Figure 4-15 1/O ports — Port2

P45 is used as one of the LCD control lines, together with P46 and P47. Configure these lines as shown in
Figure 4-16.

ﬂ Peripheral Functions 52 3 Code Preview 1 Properties ﬁ.] Generate Code {1] ¥ =8
| Part | Fart1 I Paort2 I Port3 | Portd | Part5 | PartE I Paort? | Paortd | Paort3 | Partd, I FortB I PartC | PartD | PartE | PartF | PaortG | Part) | i
- P40
@ Unuzed D lm oy ) Out oy Pull-up CrOS oukput Dutput 1
-4
@ Unuzed ) In ) Ot Pull-up CrOS oukput Dutput 1
P4z =
@ Unuzed ) In (70 Out Pull-up CMOS output Dutput 1
- P43
@ Unuzed ) In (70 Out Pull-up CrOS oukput Dutput 1
- P44 L.
@ Unuzed @) In (70 Out Pull-up CrOS oukput Dutput 1
- P45
) Unuzed ) In @ Dut Pull-up CMOS output - Cutput 1
- P4E
) Unuzed ) In @ Dut Pull-up CMOS output - Cutput 1
- P47
) Unuzed @) In @ Out Pull-up CrOS output - [ Output 1
] 1l b

Figure 4-16 1/O ports — Port4
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Peripheral function configuration is now complete. Save the project using the File -> Save, then click

‘Generate Code’.

The Console pane should report ‘The operation of generating file was successful’, as shown

Figure 4-17 below.

Bl Consale 52 [ Problems o ._-3| al *[f== 0
Code Generator Console

MRA@9202 :The generating source folder is: CihvWeorkspacehCs Tuterialh »
Ha21a22@1 :The following files were generated:

Had@a2aa
Had@a2aa
Had@a2aa

Hadaaaaad
Hadaaaaad

Had@a2aa
Had@a2aa
H22920a
Had@a2aa

Hadaaaaad
Had@aaaa
Hadaaaaad

Had@a2aa

Hadaaaaad

Had@a2aa

Mg 2922a

Had@a2aa
Had@a2aa

Hadaaaaa
Hadaaaaad
Hadaaaaad

Had@a2aa
Had@a2aa
Had@a2aa
Had@a2aa
Had@a2aa
H2A 29203 :

Hadaaaaad
Hadaaaaad

H3d@9aaad :

H2d292a3

srehep srehr o main. € was generated.

srehep srehr o dbsct.c was generated.

srehepE srehr o intprg.c was generated.

isrchep srehr e resetprE.c was generated,

isrehep sreh o shrk.c was generated.

srehep srehr o wectthl.c was generated.

sreheg srehr e sbrk.h was generated.

srehep srehr o stacksct.h was generated.

m

sreheg srehr e wect.h was generated.

isrchep srehr e hardware setup.c was generated.

isrohecg srehr o macrodriver.h was generated.

isrchep srehr e userdefine.h was generated.

srehcE sl EF cEc.c was generated.

isrchep srehr EF CFc user.c was generated,

sreheg srehr e cgc.h was generated.

isredeg sreht o lcu.c was generated.

srehep srehr £ 1cu user.c was generated.

srehep srehr e icu.h was generated.

isrehcE srehi o port.c was generated.

isrchep srehr e port user.c was generated.

isrchep srehr e port.h was generated.

srehep srchr o omb.c was generated.

srehep srehr cf embt user.c was generated.

sreheg srehr o emt.h was generated.

srehep srehr e sci.c was generated.

srehep srehr £ scl user.c was generated.

sreheg srehr o scilh was generated.

isrchep srehr e s12ad.c was generated.

isrchep srehr e s12ad user.c was generated.

sreheg srehr o slZad.h was generated.

:The operation of generating file was successful.

Figure 4-17 Code generator console
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4.4 Building the Project

The project is template created by Code Generator can now be built. In the Project Explorer pane expand the
‘src’ folder. The three files created by the New Project Wizard in 83.2 have been excluded from the build
automatically as part of the code generation procedure as shown in Figure 4-18. This is because the main()
function now resides in r_cg_main.c in the cg_src folder and the type definitions and setting of sections has
been handled by the Code Generator.

7 Project Explorer B3 — <,1=’=f> |
4 =% CG_Tutorial [HardwareDebuqg]
» e Includes
4 [ sec
¢ [ Cg_src

> iodefine.h
[# CG_Tutorial.c
[# dhsct.c

] typedefine.h

Figure 4-18 Files excluded from the build by Code Generator

Switch back to the ‘C/C++' perspective using the gy C/C++ button on the top right of the e® studio
workspace. Use ‘Build Project’ from the ‘Project’ menu or the %' button to build the tutorial. The project
will build with no errors.
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5.User Code Integration

In this section the remaining application code is added to the project. Source files found on the RSK+ DVD
are copied into the workspace and the user is directed to add code in the user areas of the code generator
files.

Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for _xxxxx_. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Code Generator, if the user needs to subsequently change any of the Code Generator-generated code.

5.1 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK+. Locate the files ascii.h , r_okaya_lcd.h,
ascii.c, and r_okaya_lcd.c on the RSK+ DVD. These files can be found in the Tutorial project for e’ studio.
Copy these files into the C:\Workspace\CG_Tutorial\src directory. The files will be automatically added to the
project as shown in Figure 5-1.

L Project Explorer 23 — <§>

4 *_5 CG_Tutorial [HardwareDebug]
> i{,—f Binaries
o [wpt) Includes
a8 s
¢ e Cg_srC
- g asciic
- [k asciih
. indefine.h
- g rokaya_lcd.c
. r_okaya_lcd.h

[#H 5 Tokarial -

Figure 5-1 Adding files to the project

In the e’ studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_userdefine.h’ by double-
clicking on it. Insert the following #defines in between the user code delimiter comments as shown below.

/* Start user code for function. Do not edit comment generated here */
#define TRUE (€D

#define FALSE )

/* End user code. Do not edit comment generated here */

In the same folder open the file ‘'r_cg_main.c’ by double-clicking on it. Insert the following code in between the
user code delimiter comments as shown below.

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya_lcd.h"
/* End user code. Do not edit comment generated here */

Scroll down to the ‘main()’ function and insert the highlighted code as shown below into the beginning of the
user code area of the main() function:

void main(void)

{
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R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the debug LCD */
R_LCD_Init(Q);

/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSK+RX71M ');
R_LCD_Display(1l, (uint8_t *)" Tutorial ');
R_LCD_Display(2, (uint8_t *)'" Press Any Switch ');
while (1U)

{

3

/* End user code. Do not edit comment generated here */

¥
5.1.1 SPI Code
The Okaya LCD display is driven by the SPI Master that was configured using Code Generator in 84.3.5. In

the e’ studio Project Tree, open the file ‘r_cg_sci.h’ by double-clicking on it. Insert the following code in the
user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */
MD_STATUS R_SCI6_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);
/* End user code. Do not edit comment generated here */

Now, open the r_cg_sci_user.c file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */
/* Flag used locally to detect transmission complete */

static volatile uint8_t sci6_txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmitend call-back function for SCI6:

static void r_sci6_callback_transmitend(void)
/* Start user code. Do not edit comment generated here */

sci6_txdone = TRUE;
/* End user code. Do not edit comment generated here */

}
Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/

* Function Name: R_SCI6_SPIMasterTransmit

* Description : This function sends SPI6 data to slave device.
* Arguments : tx_buf -

* transfer buffer pointer

* t>x_num -

* buffer size

* Return Value : status -

*

MD_OK or MD_ARGERROR

/
MD_STATUS R_SCI6_SPIMasterTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
sci6_txdone = FALSE;

/* Send the data using the API */
status = R_SCI6_SPI1_Master_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci6_txdone)

/* Wait */
}
return (status);
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N

End of function R_SCI16_SPIMasterTransmit

/
This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.

5.1.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Code Generator in 84.3.3. Open the file r_cg_cmt.h
and insert the following code in the user area for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT_MsDelay(const uintl6_t millisec);
/* End user code. Do not edit comment generated here */

Open the file r_cg_cmt_user.c and insert the following code in the user area for global at the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8_t one_ms_delay complete = FALSE;
/* End user code. Do not edit comment generated here */

Scroll down to the r_cmt_cmiO_interrupt() function and insert the following line in the user code area:
static void r_cmt_cmiO_interrupt(void)

/* Start user code. Do not edit comment generated here */

one_ms_delay_complete = TRUE;

/* End user code. Do not edit comment generated here */

}
Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/
* Function Name: R_CMT_MsDelay
* Description : Uses CMTO to wait for a specified number of milliseconds
* Arguments : uintl6_t millisecs, number of milliseconds to wait
* Return Value : None
/
void R_CMT_MsDelay (const uintl6_t millisec)
uintlé_t ms_count = O;
do
{
R_CMTO_Start();
while (FALSE == one_ms_delay_complete)
{
/* Wait */
¥
R_CMTO_Stop(Q);
one_ms_delay_complete = FALSE;
ms_count++;
3} while (ms_count < millisec);
}
/
End of function R_CMT_MsDelay
/
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5.2 Additional include paths

Before the project can be built the compiler needs some additional include paths added. Select the
CG_Tutorial project in the Project Explorer pane. Use the @ button in the toolbar to open the project settings.

Navigate to ‘C/C++ Build -> Settings ->Compiler -> Source and click the | button as shown in below in
Figure 5-2.

Properties for CG_Tutorial = I@

type filter text Settings L=l r v

» Resource -
Builders 4 B Compiler Include file directories &5 2 "

f i - | Source
4 GG Build S o "STCINSTALLY include”
Build Variables (2 Object
2 List

- (B2 Optimize
[ Miscellaneous
(B2 User

Change Toolchain Vers
Dependency Scan
Device

Environment

Logging » (2 CPU
Settings # PIC/PID

Tool Chain Editar 4 1 Assembler Preinclude files &)
@ Source

- (2 Object
(B List
(# Miscellaneous
25 User

a4 B Linker

- (2 Input
@ List

- (22 Optimize Defines 28 8

. B Carbimm

» C/C++ General
Project References
Run/Debug Settings

> Task Repository

m

Figure 5-2 Adding additional search paths

In the ‘Add directory path’ dialog, click the ‘Workspace’ button and in the ‘Folder selection’ dialog browse to the
‘CG_Tutorial/src’ folder and click ‘OK’.e® studio formats the path as show in Figure 5-3 below.

le%] Add directory path ==

Directory:

-

Sfworkspace_loc/${ProjMNamel/src}

oK ] ’ Cancel ] | Workspace... | [ File system...

Figure 5-3 Adding workspace search path

Repeat the above steps to add the ‘src/cg_src’ workspace search path. Select ‘Build Project’ from the ‘Project’

-

menu, or use the button.e” studio will build the project with no errors.

The project may now be run using the debugger as described in 86. The program will display ‘RSK+RX71M
Tutorial Press Any Switch’ on 3 lines in the LCD display.
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5.3 Switch Code Integration

API functions for user switch control are provided with the RSK. Locate the files rskrx71mdef.h,
r_rsk_switch.h and r_rsk_switch.c on the RSK DVD. These files can be found in the Tutorial project for e’
studio. Copy these files into the C:\Workspace\CG_Tutorial\src directory. Import these three files into the
project in the same way as the lcd files.

The switch code uses interrupt code in the files r_cg_icu.h, r_cg_icu.c and r_cg_icu_user.c and timer code in
the files r_cg_cmt.h, r_cg_cmt.c and r_cg_cmt_user.c, as described in §4.3.2 and 84.3.3. It is necessary to
provide additional user code in these files to implement the switch press/release detection and de-bouncing
required by the API functions in r_rsk_switch.c.

53.1 Interrupt Code

In the e® studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_icu.h’ by double-clicking on
it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU_IRQ */
uint8_t R_ICU_IRQIsFallingEdge(const uint8_t irg_no);

void R_ICU_IRQSetFallingEdge(const uint8_t irg_no, const uint8_t set_f_edge);
void R_ICU_IRQSetRisingEdge(const uint8_t irg_no, const uint8_t set_r_edge);

/* End user code. Do not edit comment generated here */

Now, open the r_cg_icu.c file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/
* Function Name: R_ICU_IRQIsFallingEdge
* Description : This function returns 1 if the specified ICU_IRQ is set to
* falling edge triggered, otherwise 0.
* Arguments : uint8_t irg_no
* Return Value : 1 if falling edge triggered, O if not
/
uint8_t R_ICU_IRQIsFallingEdge (const uint8_t irg_no)
{
uint8_t falling_edge_trig = 0x0;
if (ICU.IRQCRLirg_no]-BYTE & _04 ICU_IRQ_EDGE_FALLING)
falling_edge_trig = 1;
¥
return falling_edge_trig;
}
/
* End of function R_ICU_IRQIsFallingEdge
/
/
* Function Name: R_ICU_IRQSetFallingEdge
* Description : This function sets/clears the falling edge trigger for the
* specified ICU_IRQ.
* Arguments : uint8_t irg_no
* uint8_t set_T _edge, 1 if setting falling edge triggered, O if
* clearing
* Return Value : None
/
void R_ICU_IRQSetFallingEdge (const uint8_t irg_no, const uint8_ t set f_edge)
iT (1 == set_fT _edge)
ICU.IRQCR[irg_no].BYTE |= _04_ICU_IRQ_EDGE_FALLING;
}
else
ICU. IRQCR[irg_no]-BYTE &= (uint8_t) ~_04_ICU_IRQ_EDGE_FALLING;
}
}
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/
* End of function R_ICU_IRQSetFallingEdge

Function Name: R_ICU_IRQSetRisingEdge

Description : This function sets/clear the rising edge trigger for the
specified ICU_IRQ.

Arguments  uint8_t irg_no
uint8_t set_r_edge, 1 if setting rising edge triggered, O if
clearing

Return Value : None

ook X X % X XN\

void R_ICU_IRQSetRisingEdge (const uint8_t irg_no, const uint8_t set_r_edge)
if (1 == set_r_edge)
ICU. IRQCR[irqg_no].BYTE |= _08_ICU_IRQ EDGE RISING;
}

else

ICU. IRQCR[irg_no].BYTE &= (uint8_t) ~ 08_ICU_IRQ_EDGE_RISING;

N

End of function R_ICU_IRQSetRisingEdge

/

/* End user code. Do not edit comment generated here */

Open the r_cg_icu_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */
/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch._h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_icu_irq2_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Switch 2 callback handler */

R_SWITCH_IsrCallback2();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_icu_irg5_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Switch 1 callback handler */

R_SWITCH_IsrCallbackl1();

/* End user code. Do not edit comment generated here */

5.3.2 De-bounce Timer Code

Open the r_cg_cmt_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */
/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch._h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_cmt_cmil_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Stop this timer - we start it again in the de-bounce routines */
R_CMT1_Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCallback();
/* End user code. Do not edit comment generated here */
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In the same file insert the following code in the user code area inside the function r_cmt_cmi2_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Stop this timer - we start it again in the de-bounce routines */
R_CMT2_Stop(Q);

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCallback();
/* End user code. Do not edit comment generated here */

5.3.3 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In 84.3.4 we configured the ADC to be triggered from the ADTRGO# pin. In this code,
we also perform software triggered A/D conversion from the user switches SW1 and SW2, by reconfiguring
the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the e” studio Project Tree open the file ‘r_cg_userdefine.h’. Insert the following code the user code area,
resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */
#define TRUE (€D
#define FALSE )

extern volatile uint8_t g_adc_trigger;
/* End user code. Do not edit comment generated here */

Open the file ‘'r_cg_main.c’ and insert #include "r_rsk_switch.h" in the user code area for include, resulting in
the code shown below:

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya_lcd.h"

#include "r_rsk_switch.h"

/* End user code. Do not edit comment generated here */

Next add the switch module initialization function call highlighted in the user code area inside the main()
function, resulting in the code shown below:

void main(void)

{
R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Initialize the debug LCD */
R_LCD_InitQ);
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)'" RSK+RX71M ");
R_LCD Display(1, (uint8_t *)'" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
while (1U)
/* End user code. Do not edit comment generated here */
¥

In the same file, insert the declarations in the user code area for global, resulting in the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Prototype declaration for cb_switch _press */
static void cb_switch_press (void);

/* Prototype declaration for get _adc */
static uintl6_t get_adc(void);
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/* Prototype declaration for lcd_display_adc */
static void lcd_display adc (const uintl6_t adc_result);

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* End user code. Do not edit comment generated here */

Next add the highlighted code below in the user code area inside the main() function and the code inside the
while loop, resulting in the code shown below:

void main(void)
{
R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH_Init(Q);

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);

/* Initialize the debug LCD */
R_LCD_Init ;

/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSK+RX71M ');
R_LCD_Display(1, (uint8_t *)" Tutorial ");

R_LCD _Display(2, (uint8_t *)" Press Any Switch ");

/* Start the A/D converter */
R_S12AD0O_Start();

while (1U)
{
uintlé_t adc_result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g_adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;

3

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else iIf (TRUE == g_adc_complete)

{

/* Get the result of the A/D conversion */
R_S12AD0O_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Reset the flag */
g_adc_complete = FALSE;

}

/* End user code. Do not edit comment generated here */

3
Then add the definition for the switch call-back, get_adc() and Icd_display_adc() functions in the user code
area for adding at the end of the file, as shown below:

/* Start user code for adding. Do not edit comment generated here */

/

* Function Name : cb_switch_press

* Description : Switch press callback function. Sets g_adc_trigger flag.

* Argument > hone
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* Return value : none

static void cb_switch_press (void)

{

/* Check if switch 1 or 2 was pressed */
ifT (g_switch_flag & (SWITCHPRESS_1 | SWITCHPRESS_2))

/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch_flag = 0x0;

* End of function cb_switch_press

Function Name : get_adc

Description : Reads the ADC result, converts it to a string and displays
it on the LCD panel.

Argument I none

Return value : uintl6_t adc value

Ok X ok XN

static uintl6_t get _adc (void)
{

/* A variable to retrieve the adc result */
uintlé_t adc_result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R_S12AD0O_Stop();

/* Start a conversion */
R_S12ADO_SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g_adc_complete)

/* Wait */
}

/* Stop conversion */
R_S12ADO_SWTriggerStop();

/* Clear ADC flag */
g_adc_complete = FALSE;

R_S12AD0O_Get_ValueResult(ADCHANNELO, &adc_result);
/* Set AD conversion start trigger source back to ADTRGOn pin */

R_S12AD0_Start();

return adc_result;
by
/

* End of function get_adc

Function Name : lcd_display_adc

Description : Converts adc result to a string and displays
it on the LCD panel.

Argument : uintlé_t adc result

Return value : none

XX X X EN

static void lcd_display_adc (const uintl6_t adc_result)

/* Declare a temporary variable */
uint8_t a;

/* Declare temporary character string */
char lcd_buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */
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a = (uint8_t)((adc_result & OxOF00) >> 8);

Icd_buffer[6] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));
a = (uint8_t)((adc_result & 0x00F0) >> 4);

Icd_buffer[7] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));
a = (uint8_t)(adc_result & Ox000F);

Icd_buffer[8] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

/* Display the contents of the local string lcd_buffer */
R_LCD_Display(3, (uint8_t *)lcd_buffer);

* N

End of function lcd_display_adc

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_s12ad.h’ by double-clicking on it. Insert the following code in the in the user code area for
function, resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8_t g_adc_complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R_S12ADO_SWTriggerStart(void);

void R_S12AD0O_SWTriggerStop(void);

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_sl12ad.c’ by double-clicking on it. Insert the following code in the user code area for
adding at the end of the file, as shown below:

/* Start user code for adding. Do not edit comment generated here */

Function Name: R_S12ADO_SWTriggerStart

Description : This function starts the ADO converter.
Arguments : None

Return Value : None

LN T I N

void R_S12ADO_SWTriggerStart(void)

IR(PERIB, INTB129) = OU;

IEN(PERIB, INTB129) = 1U;
ICU.GENBL1.BIT.EN19 = 1U;
S12AD.ADCSR.BIT.ADST = 1U;

3

/
End of function R_S12AD0 SWTriggerStart

Function Name: R_S12ADO_SWTriggerStop

Description : This function stops the ADO converter.
Arguments : None

Return Value : None

L T R N

void R_S12ADO_SWTriggerStop(void)

{
S12AD.ADCSR.BIT.ADST = 0U;
IEN(PERIB, INTB129) = 0OU;
IR(PERIB, INTB129) = 0OU;
ICU.GENBL1.BIT.EN19 = 0OU;

3

/

End of function R_S12ADO_SWTriggerStop

/* End user code. Do not edit comment generated here */

Open the file r_cg_sl12ad_user.c and insert the following code in the in the user code area for global, resulting
in the code shown below:

/* Start user code for global. Do not edit comment generated here */
/* Flag indicates when A/D conversion is complete */
volatile uint8_t g_adc_complete;
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/* End user code. Do not edit comment generated here */

Insert the following code in the in the user code area of the r_s12ad0_interrupt () function, resulting in the
code shown below:

static void r_s12adO_interrupt(void)

/* Start user code. Do not edit comment generated here */
g_adc_complete = TRUE;
/* End user code. Do not edit comment generated here */

-
Select ‘Build Project’ from the ‘Project’ menu, or use the ﬁ button. e studio will build the project with no
errors.

}

The project may now be run using the debugger as described in 86. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the
LCD panel. Return to this point in the Tutorial to add the UART user code.

5.4 Debug Code Integration

API functions for trace debugging via the RSK+ serial port are provided with the RSK+. Locate the files
r_rsk_debug.h and r_rsk_debug.c on the RSK+ DVD. These files can be found in the RSKRX71M_Tutorial
project for e’ studio. Copy these files into the C:\Workspace\CG_Tutorial\src directory. Import these two files
into the project in the same way as the LCD files.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL_DEBUG_WRITE (R_SCI7_AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.5 UART Code Integration

551 SCICode

In the e” studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_sci.h’ by double-clicking on
it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */

MD_STATUS R_SCI6_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

MD_STATUS R_SCI7_AsyncTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

/* Character is used to receive key presses from PC terminal */
extern uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
extern volatile uint8_t g_tx_flag;

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_sci_user.c. Insert the following code in the user area for global near the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
volatile uint8_t g_tx_flag = FALSE;

/* Flag used locally to detect transmission complete */
static volatile uint8_t sci6_txdone;
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static volatile uint8_t sci7_txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the r_sci7_callback_transmitend()
function:

static void r_sci7_callback_transmitend(void)

/* Start user code. Do not edit comment generated here */
sci7_txdone = TRUE;

/* End user code. Do not edit comment generated here */

}

In the same file, insert the following code in the user code area inside the r_sci7_callback receiveend()
function:

static void r_sci7_callback_receiveend(void)

{

/* Start user code. Do not edit comment generated here */
/* Check the contents of g _rx char */
iIf (("c” == g_rx_char) || (°C" == g_rx_char))

g_adc_trigger = TRUE;
¥

/* Set up SCI7 receive buffer and callback function again */
R_SC17_Serial_Receive((uint8_t *)&g_rx_char, 1);

/* End user code. Do not edit comment generated here */

}

At the end of the file, in the user code area for adding, add the following function definition:

Function Name: R_SCI17_AsyncTransmit
Description : This function sends SCI7 data and waits for the transmit end flag.
Arguments - tx_buf -

transfer buffer pointer

t>x_num -

buffer size
Return Value : status -

MD_OK or MD_ARGERROR

ok X X X X Ok XN\

/
MD_STATUS R_SCI7_AsyncTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
sci7_txdone = FALSE;

/* Send the data using the APl */
status = R_SCI7_Serial_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci7_txdone)

{
/* Wait */

return (status);

}

/
* End of function R_SCI7_AsyncTransmit

/* End user code. Do not edit comment generated here */
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55.2 Main UART code

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "r_rsk debug.h"

Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for uart_display_adc */
static void uart_display_adc(const uint8_t adc_count, const uintl6_t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8_t adc_count = 0;

Add the following highlighted code to the user code area in the main function:
void main(void)

R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH_InitQ;

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCallback(cb_switch_press);

/* Initialize the debug LCD */
R_LCD_Init Q;

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)" RSK+RX71M ');

R_LCD Display(1, (uint8_t *)" Tutorial ");

R_LCD Display(2, (uint8_t *)" Press Any Switch ");

/* Start the A/D converter */
R_S12AD0O_Start();

/* Set up SCI7 receive buffer and callback function */
R_SC17_Serial_Receive((uint8_t *)&g_rx_char, 1);

/* Enable SCI7 operations */
R_SCI7_Start();

while (1U)

/* Wait for user requested A/D conversion flag to be set */
ifT (TRUE == g_adc_trigger)
{

uintl6é_t adc_result;

/* Call the function to perform an A/D conversion */
adc_result = get_adc();

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count */
if (16 == ++adc_count)
{

}

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

adc_count = 0;

/* Reset the flag */
g_adc_trigger = FALSE;

by

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{
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/* Get the result of the A/D conversion */
R_S12AD0O_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count */
if (16 == ++adc_count)
{

}

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

adc_count = 0;

/* Reset the flag */
g_adc_complete = FALSE;
}

/* End user code. Do not edit comment generated here */

}

Then, add the following function definition in the user code area at the end of the file:

/

* Function Name : uart_display_adc

* Description : Converts adc result to a string and sends it to the UARTL.
* Argument : uint8_t : adc_count

* uintl6é_t: adc result

* Return value : none

/
static void uart_display_adc (const uint8_t adc_count, const uintl6_t adc_result)
{

/* Declare a temporary variable */

char a;

/* Declare temporary character string */
static char uart_buffer[] = "ADC xH Value: xxxH\r\n';

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char)(adc_count & 0x000F);

uart_buffer[4] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (char)((adc_result & 0OxOF00) >> 8);

uart_buffer[14] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (char)((adc_result & 0x00F0) >> 4);

uart_buffer[15] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (char)(adc_result & 0x000F);

uart_buffer[16] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

/* Send the string to the UART */
R_DEBUG_Print(uart_buffer);

}

/
* End of function uart_display_adc

/
Select ‘Build Project’ from the ‘Build’ menu. e studio will build the project with no errors.

The project may now be run using the debugger as described in §6. Connect the RSK+ G1CUSBO port to a
USB port on a PC. If this is the first time the RSK+ has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will now appear under 'Port (COM & LPT)'
as 'RSK USB Serial Port (COMXx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI7 (see §4.3.5).
When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC
terminal program via the via SCI7. Return to this point in the Tutorial to add the LED user code.
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5.6 LED Code Integration

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "rskrx71lmdef._h"
/* End user code. Do not edit comment generated here */

Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for led_display_count */
static void led_display_count(const uint8_t count);

Add the following highlighted code to the user code area in the main function:

void main(void)

{
R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init Q;
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSK+RX71M ');
R_LCD Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Sart the A/D converter */
R_S12ADO_Start();
/* Set up SCI7 receive buffer and callback function */
R_SC17_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* Enable SCI7 operations */
R_SC17_Start();
while (1VU)
t
uintl6é_t adc_result;
/* Wait for user requested A/D conversion flag to be set(SW1 or SW2) */
if (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Increment the adc_count and display using the LEDs */
if (16 == ++adc_count)
{
adc_count = 0;
led_display_count(adc_count);
/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);
/* Reset the flag */
g_adc_trigger = FALSE;
ks
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g_adc_complete)
/* Get the result of the A/D conversion */
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R_S12AD0O_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count and display using the LEDs */
if (16 == ++adc_count)
{

adc_count = 0;

led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_complete = FALSE;
}

/* End user code. Do not edit comment generated here */

}

Then, add the following function definition in the user code area at the end of the file:

/
* Function Name : led_display_count
* Description : Converts count to binary and displays on 4 LEDSO-3
* Argument I uint8_t count
* Return value : none
/
static void led_display_count (const uint8_t count)
{
/* Set LEDs according to lower nibble of count parameter */
LEDO = (count & Ox01) ? LED_ON : LED_OFF;
LED1 = (count & 0x02) ? LED_ON : LED_OFF;
LED2 = (count & 0Ox04) ? LED_ON : LED_OFF;
LED3 = (count & 0x08) ? LED_ON : LED_OFF;
}
/
* End of function led_display_count
/

/* End user code. Do not edit comment generated here */
Select ‘Build Project’ from the ‘Build’ menu, or press F7. e’ studio will build the project with no errors.

The project may now be run using the debugger as described in 86. The code will perform the same but now
the LEDs will display the adc_count in binary form.
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6. Debugging the Project

In the Project Explorer pane, ensure that the ‘CG_Tutorial' project is selected. To enter the debug
configurations click upon the arrow next to the debug button and select ‘Debug Configuration’. In order to run
the project there are two setting under ‘Renesas GDB Hardware Debugging’ -> ‘Connection Settings’ that

need modifying.

Ensure that in debug configuration that the ‘Power Target From The Emulator(MAX 200mA) is set to No , and
the ‘Extal Frequency’ is set to the correct frequency, this can be found from the device schematics (in the case

of RSK+RX71M the setting

For more information on powering the RSK+RX71M please refer to the Usermanual.

EIEE
type filter text

[£] GDBE Hardware Debugging
[c7 GDB Sirmulator Debugging {
iy GHS Local C/C++ Launch
&5 Renesas GDB Hardware Atz
4 [c7 Renesas GDB Hardware Deb
[67 CG_Tutorial HardwareD:
[E7 CG_Tutorial Release
[c7 Renesas Simulator Debuggi

4 11 2

Filter ratched 8 of 12 iterns

should be 24.00000).

Mame: CG_Tutarial HardwareDebug
= Main E'ﬁ;ﬁDebugger [ Startup E Source | [ Common

Debug hardware: |EL (RX) | Target Device: | RSFSTIML
GDEB Settings | Connection Settings | Debug Taol Settings

m

4 Clock
ain Clock Source EXTAL
Extal Frequency[hHz] [z4.0000
Permit Clock Source Change On Writing Intern Yes

4 Connection with Target Board
Ermulator (Suto)
Connection Type ITag
ITag Clock Frequency[MHz] 16.5
Fine Baud Rate[Mbps] 2.00
Hot Plug [Ma

4 Power
Pouver Target From The Emulator (M&X 200ma Mo
Supply Woltage EEL

4 CPU Operating Mode
Register Setting Single Chip
hdada wmin Sinole-chin mnda

Lpply

Cebug

Rewert

Clase

Figure 6-1 Debug Configurations

To debug the project, click the 35 button. The dialog shown in Figure 6-2will be displayed.
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-

ﬁ Confirm Perspective Switch
p

This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective is designed to support application debugging. It

incorporates views for displaying the debug stack, variables and breakpoint
management.

Do you want to open this perspective now?

[] Remember my decision

Figure 6-2 Perspective Switch Dialog

Click ‘OK’ to confirm that the debug window perspective will be used. The debugger will start up and the code
will stop at the Code Generator function ‘PowerOn_Reset_PC’ as shown in Figure 6-3.

Debug - CG_Tutorial/src/cg_src/r_cq_resetprg.c - e studio
File Edit 5ource Refactor MNavigate Search Project Run Windew Help
S A= ER - 2 S SR R R Wi O 0 Q

%5 Debug &2 L~ P{EE|id| =8 ®va
a [c7] CG_Tutorial HardwareDebug [Renesas GDB Hardware Debugging]
4 ,'jj::? CG_Tutonialax [1] Mame
4 g Thread [1]1 (single core) (Suspended : Signal : SIGINT:Interrupt)
= PowerON_Reset PC() at r_cg_resetprg.c:66 0xffc00000
wd gdb
gt GDB server

[ r_cg_resetprg.c 3
= ffceeeee - void PowerON_Reset PC(void)

{
- #ifdef _ RXV2
59 ffceasee set_extb(_ sectop("EXCEPTVECT"));

#endif
ffeeaal7 set_intb(_ sectop("CHVECT"));
- #ifdef _ ROZ /* Initialize FPSW */
#define _ROUND ex@eeeenl /* Let FPSW RMbits=81 (round to zero) */
- #else
#define _ROUND expopopena /* Let FPSW RMbits=@@ (round to nearest) */
#endif

- gifdef _ DOFF

1| 1

El Console &1 | 4% Tasks = Renesas Coverage Memory Usage (- - Performance Analysis (2 Profile !EZReal—time Chi

CG_Tutorial HardwareDebug [Renesas GDE Hardware Debugging] gdb

monitor set_io_access_width,RW,1,clc84-clcB6,clc94-clc96,clcad-clcab,clch2,clcb4,clche,dBeaz , depe
monitor set_io_access_width,RW,1,del2e8-de123,del2s-del2f,7fedle,7fenls, 7fe0ls, 7feaoae, 7febda, 7febd

Figure 6-3 Debugger start up screen

To run the code click the UB button. The debugger will stop again at the beginning of the main() function.
Press L again to run the code.
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7.Additional Information

Technical Support

For details on how to use e” studio, refer to
the help file by opening e’ studio, then
selecting Help > Help Contents from the  “Window [Help

menu bar. LG (ofé:l Wielcome

{(7) Help Contents
7 Search
Dynarnic Help

For information about the RX71M group microcontroller refer to the RX71M Group Hardware Manual.
For information about the RX assembly language, refer to the RX Family Software Manual.
For more information about the Tutorial sample please refer to the Tutorial manual.
Technical Contact Details
Please refer to the contact details listed in section 8 of the “Quick Start Guide”

General information on Renesas microcontrollers can be found on the Renesas website at:
http://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe Limited.

© 2015 Renesas Electronics Europe Limited. All rights reserved.
© 2015 Renesas Electronics Corporation. All rights reserved.
© 2015 Renesas System Design Co., Ltd. All rights reserved.
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